NOTES & BIBLIOGRAPHY STYLE

This guide describes the humanities style (notes & bibliography) that is preferred by many in the arts, literature, and history. The “author-date” style is reserved for the physical, natural and social sciences and is not covered by this guide.

<table>
<thead>
<tr>
<th>TABLE OF CONTENTS CONTINUED</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PERIODICALS – ONLINE &amp; PRINT</strong></td>
</tr>
<tr>
<td>JOURNAL ARTICLE FORMATTING NOTES</td>
</tr>
<tr>
<td>JOURNAL ARTICLE – WITH A DOI</td>
</tr>
<tr>
<td>JOURNAL ARTICLE – WITHOUT A DOI</td>
</tr>
<tr>
<td>MAGAZINES OR NEWSPAPER – ONLINE &amp; PRINT</td>
</tr>
<tr>
<td><strong>BOOKS – ELECTRONIC &amp; PRINT</strong></td>
</tr>
<tr>
<td>BOOK FORMATTING NOTES</td>
</tr>
<tr>
<td>ORDER OF ELEMENTS WHEN CITING A BOOK</td>
</tr>
<tr>
<td>PRINT BOOK</td>
</tr>
<tr>
<td>ELECTRONIC BOOK</td>
</tr>
<tr>
<td>ARTICLE OR CHAPTER IN AN EDITED COLLECTION</td>
</tr>
<tr>
<td>ENTRY IN A REFERENCE BOOK – ONLINE &amp; PRINT</td>
</tr>
<tr>
<td><strong>AUDIOVISUAL MEDIA</strong></td>
</tr>
<tr>
<td>ORDER OF ELEMENTS FOR MULTIMEDIA CITATIONS</td>
</tr>
<tr>
<td>STREAMING VIDEO</td>
</tr>
<tr>
<td>FILM/DVD</td>
</tr>
<tr>
<td>PODCAST</td>
</tr>
<tr>
<td><strong>WEBSITES &amp; SOCIAL MEDIA</strong></td>
</tr>
<tr>
<td>WEBSITE FORMATTING NOTES</td>
</tr>
<tr>
<td>WEBPAGE WITH AN AUTHOR</td>
</tr>
<tr>
<td>WEBPAGE – ORGANIZATION AS AUTHOR OR NO AUTHOR</td>
</tr>
<tr>
<td>BLOGPOST</td>
</tr>
<tr>
<td>LIBRARY OF CONGRESS DIGITAL COLLECTION</td>
</tr>
</tbody>
</table>

Scan to be linked to a sample paper in Chicago Style
GENERAL FORMATTING GUIDELINES

Your professors will expect to receive papers that are properly formatted. Unless otherwise requested by your professor, use the following guidelines when setting up a paper in Chicago Style.

- One inch margins on sides, top, and bottom
- Times New Roman, 12 pt. font
- Double-space the text (except for block quotes, footnotes, and bibliography entries).
- Use a ½ inch indent for paragraph beginnings, block quotes, and hanging indents.
- Left-align text so that it has a ragged right edge. Do not use newspaper justified text.
- Number the pages in the top right corner of the header beginning with the first page of text (not the title page). Some professors also like your last name included with the page number.
- Remove extra spacing between paragraphs.

COVER PAGE

Should your paper require a title page, use the following guidelines.

1. The title should be centered one-third of the way down the page in ALL CAPS.
2. If there is a sub-title, end your title with a colon and enter the sub-title on a separate line.
3. Your name, class information, and the date should follow several lines later.
4. Double-space each line of the cover page.
5. Do not put a page number on the cover page.

NOTE: While most formal research papers require a title page, not all writing assignments make use of them. When in doubt, ask your instructor.

The top portion of a sample Chicago style title page

NEFERTITI:
QUEEN OF CONTROVERSY

Emily Gibson
History 101: History of Civilization I
October 10, 2019
**QUOTATIONS**

The CMOS requires quotation of all word-for-word material. **All quoted material must be accompanied by a footnote.**

**Footnotes** are notes that appear in the footer section of the page. In Chicago notes and bibliography style, footnotes are used to tell the reader the source of ideas or language in the text. To cite an outside source, a superscript number is placed after a quote, summary, or paraphrase. The superscript number corresponds to a numbered footnote containing source information.

**SHORT QUOTATIONS**

If a quote is **less than five lines**, incorporate it into a sentence. Enclose the quoted material in double quotation marks - "". Place the superscript number at the end of the sentence or quotation.

Quotation example:

Kim and Koh’s investigation into the relationship between smartphone obsession and self-esteem suggested that “individuals with low self-esteem may feel more anxious, and being anxious can increase one’s obsession with smartphone use.”

**LONG QUOTATIONS**

Quotes of five or more lines, or 100 or more words are called **block quotes** and are formatted differently than their shorter counterparts. When using block quotations follow the guidelines below:

- Change the line spacing to **single-spaced**, and include add an extra line before and after the block quote.
- Block quotations appear on a new line and are **indented half an inch**.
- When block quotations include multiple paragraphs, new paragraphs are further indented.
- Block quotations **do NOT make use of quotation marks**.
- Colons are frequently used when introducing a block quotation. They are not required.
- Use block quotations sparingly.

Example of a block quotation

The distinction between spirituality and religiosity is further clarified by Miller and Thoresen:

Spirituality is more concerned with how an individual has a personal relationship to larger transcendent realities, such as the universe or God, whereas religiosity is more concerned with how an individual experiences a transcendent being and how this is expressed in a community or social organization.  

---

1. This is an example of where footnotes are placed.
2. Footnotes provide additional information about a sentence and direct readers to outside sources, either to cite an idea or to suggest additional reading about a topic.
Chicago Style requires a list of sources in the form of a bibliography. The information on this list allows writers to credit sources and readers to find, evaluate, and make further use of those sources.

**What to include**
- Every source you paraphrased, summarized, or quoted in the text.
- Do not include sources that you consulted but did not cite.
- Do not include personal communications (such as emails or unpublished interviews), standard religious texts such as the Quran or Bible, classical primary sources (such as *The Iliad*) or well-known reference books (such as *Encyclopedia Britannica* or the *Oxford English Dictionary*).

**How to order the entries**
- Entries are alphabetized by the first letter in the entry, generally an author’s last name.
- Entries that have no author or editor are alphabetized by title.
- When alphabetizing by title, ignore articles that begin the title (*A*, *An*, and *The*).
- When an entry starts with a number, alphabetize the entry based on how the number would appear if written.
- When an entry starts with a year, alphabetize the entry based on how the year would be spoken.

**How to format the page**
- The bibliography begins on a new page after the conclusion.
- Include a consecutive page number in the top-right corner of the header.
- The page has the word Bibliography centered at the top without any special formatting (no bold, larger font size, or underline).
- Leave two blank lines between the word Bibliography and your first entry.
- Use “and” not “&” for multi-author entries.
- For one to ten authors in a single entry, write out all names in the bibliography (entries in the footnotes can be shortened).
- For online sources, provide DOIs instead of URLs whenever possible.
- In the 17th edition of CMOS, use of 3-em dash (---) for multiple works by the same author is discouraged (CMOS 14.67).
- **Bibliography entries are single-spaced** with one extra space between entries.
- Bibliography entries make use of a **hanging indent** (instructions for a hanging indent are on the next page).

Sample Bibliography from [Purdue OWL](https://www/owl.purdue.edu/owl/):  

**Bibliography**


HANGING INDENT

HOW TO CREATE A HANGING INDENT IN MICROSOFT WORD

1. Select the text that you would like to indent.
2. On the Home tab, click the arrow in the bottom right of the Paragraph group.
3. In the Paragraph dialog box, under Indentation, in the Special list, select Hanging.
4. The measurement should automatically set to 0.5 under By.
5. Click OK.
*Note: The Spacing before and after paragraphs should be set to 0pt.
Tip! The keyboard shortcut Ctrl + T also creates a hanging indent in Word.

HOW TO CREATE A HANGING INDENT IN GOOGLE DOCS:

1. Click “View” and make sure “Show Ruler” is checked.
2. Select the text that you would like to indent.
3. On the ruler, drag the light blue inverted triangle (Left Indent marker) to the right until it is a half inch from the margin (0.50). (The light blue rectangle will move with it.)
4. Drag the light blue rectangle (First Line Indent marker) back to the left margin (0.00).
CREDITING SOURCES

TO CREDIT CONTRIBUTORS, CHICAGO MANUAL OF STYLE (CMOS) REQUIRES (1) A SUPERSCRIPT NUMBER FOR ALL SOURCED INFORMATION, (2) FOR EACH SUPERSCRIPT NUMBER, A FOOTNOTE CONTAINING FULL (FIRST USE) OR ABBREVIATED (SUBSEQUENT USE) SOURCE INFORMATION, AND (3) A FULL LIST OF SOURCES IN THE FORM OF AN END-OF-TEXT BIBLIOGRAPHY.

FOOTNOTES

OVERVIEW

WHAT REQUIRES A FOOTNOTE

Paraphrases, summaries and quotations all require the use of footnote citations.

- A paraphrase restates the source material in new language. A paraphrase uses approximately the same number of words as the original.
- A summary condenses the source material to reflect its main idea(s). A summary uses significantly less words than the original.
- A quotation restates the source material using the exact language of that material.

HOW DOES CITATION INFORMATION APPEAR IN THE TEXT

To credit the writers and thinkers whose ideas are paraphrased, summarized and quoted, CMOS style writing makes use of both signal phrases and superscript reference numbers that correspond to a footnote.

Signal phrases (also known as attributive tags or narrative citation) signal the reader that the idea or language being used is from an outside source. Signal phrases generally use the author(s) name(s) and a verb to do this. They appear in the same sentence as the source material, either directly before or after that material. See the SIGNAL PHRASE GUIDELINES handout for guidelines and a list of signal phrase verbs.

Footnote citations make use of superscript numbers that are placed as close to the cited material as possible (normally at the end of the sentence). The superscript number corresponds to a footnote entry at the bottom of the page. If you are citing a source more than once, you can shorten the subsequent footnotes. Examples below:

In an effort to explain the cultural variations in same-family reincarnation claims, Masayuki theorized that “culturally prescribed ideas about reincarnation would be carried into death and would influence decisions made in the postmortem state.”

(Footnote entry at the bottom of the page)


Subsequent footnote example of the same work:

SHORTENING FOOTNOTES WHEN CITING A SOURCE MORE THAN ONCE  (CMOS 14.30)

The first footnote of a source includes all necessary citation information (up to three authors). Subsequent footnotes of the same source can be shortened.

Shortened footnotes include:

- The author’s or authors’ last name(s)
- A shortened version of the title
  - Titles with more than four words are shortened to around three keywords of the main title.
- The page number(s)

The 17th ed. discourages the use of Ibid. for repeated citations of the same source.

HOW TO INSERT A FOOTNOTE IN MICROSOFT WORD

1. Place your cursor where you would like the superscript number in the text body (typically after the period of the sentence you’re citing).
2. Select the “References” tab.
3. Select “Insert Footnote.” A number will automatically be inserted, and your cursor will move to the footer to allow you to complete the footnote citation.

HOW TO INSERT A FOOTNOTE IN GOOGLE DOCS

1. Place your cursor where you want the superscript number in the text body.
2. Select the “Insert” tab.
3. Select “Footnote.”

Note: In either Word or Google Docs, the keyboard shortcut to insert a footnote is **CTRL+Alt+F**.
WORKS WITH MULTIPLE AUTHORS (OR EDITORS)

TWO AUTHORS

- When a work is authored by two individuals, use and instead of ampersand (&) to separate the names.
- In the bibliography, only the first author’s name is inverted.

IN-TEXT REFERENCE:

Sarkodie and Strezov’s study revealed African countries as “the most vulnerable to climate change with high sensitivity, high exposure, and low adaptive capacity.”

FOOTNOTE ENTRY


Subsequent footnotes:


BIBLIOGRAPHY ENTRY


THREE OR MORE AUTHORS (CMOS 14.76)

- For works with three authors, include all three authors in the footnote and bibliography entries.
- For works with four or more authors, only include the first author’s name in the footnote followed by “et al.,” an abbreviation for the Latin phrase et alia meaning “and others.” The full list of authors (up to ten) can be listed in the bibliography.
- For works with ten or more authors, list the first seven in the bibliography, followed by et al.

IN-TEXT REFERENCE

Doctors Horon, Singal, Fowler, and Sharfstein point out that if death certificates include a thorough documentation of the substances involved in a death, accurate heroin overdose rates will be easier to obtain.

FOOTNOTE ENTRY

Subsequent footnotes:


**BIBLIOGRAPHY ENTRY**


**ORGANIZATION OR GOVERNMENT AS AUTHOR** (CMOS 14.84)

Some sources do not list an individual author. These sources may have an organization, corporation, association, or government agency as their author. In this case, the group’s name can be used in place of an author’s name in footnotes and bibliography entries.

**FOOTNOTE ENTRY**


**BIBLIOGRAPHY ENTRY**


**AUTHOR UNKNOWN** (CMOS 14.79)

Reference works, legal materials, and newspaper editorials frequently appear without an author. If no author is given and the source has not been authored by an agency or organization (see above), start the citation with the source’s title. Ignore initial articles (The, A, An) when alphabetizing entries in the bibliography.

**FOOTNOTE ENTRY**


**BIBLIOGRAPHY ENTRY**

**CLASSICAL PRIMARY SOURCES** (CMOS 14.243)

Classical primary sources, such as Greek and Latin texts, are ordinarily given in the text or footnotes and not included in the bibliography list. The numbers identifying parts of classical works – books, sections, lines – remain the same in all editions. Use Arabic numerals (1, 2, 3, etc.) instead of Roman numerals. Page numbers are omitted except when referencing a modern editor’s introduction or notes.

**FOOTNOTE ENTRY**

1. Author, *Title*, book.section.lines
   

**SCRIPTURAL REFERENCES** (CMOS 14.239)

Citations to religions scriptures, such as the Bible or Koran (Qur’an), usually appear in text or notes rather than the bibliography. Citations for the Bible should include the book (usually abbreviated), chapter, and verse, but no page number. A colon separates the chapter and verse(s).

**FOOTNOTE ENTRY**

1. 1 Cor. 13:4, 15:12-19.
   

**U.S. CONSTITUTION**

Citations of the U.S. Constitution are included in footnotes and left out of the bibliography. Amendment and article numbers appear in roman numerals and other subdivision numbers are in Arabic numerals (1, 2, 3, etc.). The section symbol (§) can be found in Microsoft Word’s Insert tab, symbol, more symbols, special characters. Alternatively, hold down the Alt key and type the numbers 0167 on the numeric keypad.

**FOOTNOTE ENTRY**

1. U.S. Const. art. IV, § 2, cl. 2.

**SOURCE QUOTED IN ANOTHER SOURCE** (CMOS 14.260)

Citing a source that was quoted within another source is discouraged because authors are expected to examine works they refer to. You should find the original source whenever possible. However, if the original source cannot be located, both the original and the secondary source must be cited. Separate the sources with the phrase “quoted in.”

**FOOTNOTE ENTRY**

BIBLIOGRAPHY ENTRY


PERSONAL COMMUNICATION

If you’re citing an email, text message, telephone conversation, letter, or non-archived discussion message board, it is unlikely that your reader will be able to access your source. For this reason, personal communications are not included in the bibliography.

UNPUBLISHED INTERVIEWS

FOOTNOTE ENTRY

1. [Name of interviewee]. Interviewed by [name], place and date of interview.


Subsequent footnotes:

2. Voskuil, interview.

AUTHOR AND EDITOR OR TRANSLATOR (CMOS 14.23)

Some works – typically books – have both an author and an editor or translator. In a work with both an author and an editor/translator, the editor or translator’s name is given after the title of the work. Edited is abbreviated to *ed.* in the footnote. Translated is abbreviated to *trans.* The bibliography entry does not abbreviate edited or translated.

FOOTNOTE ENTRY


Subsequent footnote:


BIBLIOGRAPHY ENTRY

PERIODICALS – ONLINE & PRINT

JOURNALS, MAGAZINES, NEWSPAPERS

JOURNAL ARTICLES – ONLINE & PRINT

JOURNAL ARTICLE FORMATTING NOTES:

• The author’s name is inverted in the bibliography but not in the footnote.
• Elements are often separated by commas in the footnote and by a period in the bibliography.
• No retrieval date is necessary for electronic resources unless requested by your instructor. If an access date is required by your instructor, it should be included immediately prior to the URL or DOI.
• The journal title is italicized.
• Use title case capitalization for journal and article titles. Do not capitalize articles (a, an, the), prepositions less than four letters long (of, on, in, by, etc.), or coordinating conjunctions (and, or) unless one of these is the first word of the journal title.
• The volume number is not italicized like it is in APA style. The abbreviation for volume, or vol., is not included. Only give the number.
• The issue number, if available, follows the volume number with a comma and is preceded by “no.”
• The publication year may be preceded by a season or month.

ONLINE JOURNAL ARTICLE WITH A DOI [DIGITAL OBJECT IDENTIFIER]

FOOTNOTE TEMPLATE


FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY

FOOTNOTE TEMPLATE

1. Firstname Lastname, “Title of Article,” Title of Journal volume #, issue # (publication year): page number.

FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY


MAGAZINE OR NEWSPAPER ARTICLES – ONLINE & PRINT

FORMATTING NOTES:

• Include as much information about the publishing date as possible. Provide the day and month if available.
• If citing a print copy of a newspaper or magazine, end the citation after the page number in the footnote entry or year in the bibliography entry.
• If no author is given for the article, begin with the article’s title instead.

FOOTNOTE TEMPLATE

1. Firstname Lastname, “Article Title,” Magazine or Newspaper Title, Month Year, page number, URL/Database.

FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY TEMPLATE

Lastname, Firstname. “Article Title.” Magazine or Newspaper Title. Day Month, Year. URL/Database.

BIBLIOGRAPHY ENTRY


BOOKS – PRINT OR ONLINE
CMOS 14.100

BOOK FORMATTING NOTES

1. Use title case capitalization for titles and subtitles.
2. If the book has been reprinted, list only the most recent year.
4. If two or more publishing locations are given, give the location listed first or, if specified, the location of the publisher’s home office.
5. For an edition other than the first, add the edition number after the title in the listing. In the footnote, a comma separates the title and edition number. In the bibliography entry, a period separates the title and edition number.

ORDER OF ELEMENTS WHEN CITING A BOOK

Not all of the elements listed below will be applicable to every book. Skip elements that do not apply to the source being cited.

1. Author(s) or name of institution standing as author
2. Title
3. Editor or translator
4. Edition, if not the first
5. Volume
6. Series title
7. Facts of publication: city, state: publisher, date
8. Page number(s)
9. URL or DOI for electronic books

PRINT BOOK

FOOTNOTE TEMPLATE

1. Firstname Lastname, Title of Work: Subtitle, # ed. (City, State: Publisher, year), page.

FOOTNOTE ENTRY


BIBLIOGRAPHY TEMPLATE

Lastname, Firstname. Title. # ed. City, State: Publisher, year.

**ELECTRONIC BOOK** (CMOS 14.161)

- When citing a book found online, include a DOI or URL at the end of the citation.
- If you are retrieving a book through a library database, a URL available to all users may not be available as library databases are available only to subscribers. Include the name of the database in italics instead of a URL.
- Some electronic books may not have fixed page numbers. If page numbers are not available in an e-book, include another location identifier such as a chapter or section number.

**FOOTNOTE TEMPLATE**

1. Firstname Lastname, *Title of eBook* (city, state: publisher, year), page number, URL/DOI/Database.

**FOOTNOTE EXAMPLES**


**BIBLIOGRAPHY TEMPLATE**


**BIBLIOGRAPHY ENTRY**


**ARTICLE OR CHAPTER IN AN EDITED COLLECTION OR ANTHOLOGY** (CMOS 14.107)

**FOOTNOTE TEMPLATE**

1. Author of chapter, “Chapter or article title,” in *Book Title*, ed. Editor Name(s) (City: Publisher, year), page number.

**FOOTNOTE ENTRY**

BIBLIOGRAPHY TEMPLATE
Author of chapter. “Chapter Title.” In Book Title, edited by name(s), page range. City: Publisher, year.

BIBLIOGRAPHY ENTRY

ENTRY IN A REFERENCE BOOK—DICTIONARY/ENCYCLOPEDIA
● Well-known reference works, such as the Oxford English Dictionary, Encyclopedia Britannica, or Wikipedia, can be cited in the footnotes and left out of the bibliography.
● Reference works that are not widely known should include full publication details like other books.
● Citations of an alphabetically arranged work (that is how reference books are usually arranged) will include the abbreviation “s.v.” which is short for the Latin phrase sub verbo or “under the word.” The plural form is s.vv. See the examples below.

PRINT REFERENCE BOOK
FOOTNOTE TEMPLATE
1. Firstname Lastname (if available), Reference Work Title, edition (year), s.v. “word.”

FOOTNOTE ENTRY

ONLINE REFERENCE WORK
FOOTNOTE TEMPLATE
1. Firstname Lastname (if available), Reference Work Title, s.v. “word,” accessed Month day, year, URL.

FOOTNOTE ENTRY

AUDIOVISUAL AND OTHER MULTIMEDIA

ORDER OF ELEMENTS FOR MULTIMEDIA CITATIONS

Note: Not every element below is going to be applicable to every source. Use whatever information you have about the source and order it in the following sequence.

1. Name of the composer, writer, director, performer, or other person primarily responsible for content. Follow the name with a designation of role, such as director or writer as appropriate.
2. Title of work in italics or quotation marks. Title of films, albums, or podcast series are italicized. Works within larger works, like a TV episode, podcast episode, or a TED talk lecture are encased in quotation marks.
3. Information about the work, such as when and where it was recorded.
4. Information about the publisher, including date of publication.
5. Information about the medium or format, such as DVD or MPEG. Length of film can also be given.
6. Any additional information that might be useful for a reader to locate item.
7. URL for sources found online.

STREAMING VIDEO

Formatting note:

• If the video is a recording of a speech or performance, include information about the original performance, such as the location and date it was filmed. See Ted Talk example below.

FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY


FILM/DVD

The order of the elements listed for film depends on whether you’re citing a particular episode or an entire work and whether a particular contributor (such as a writer, actor, or director) is the focus of the citation. For more film examples see Purdue Owl’s website.

FOOTNOTE ENTRY

2. Michael Kirk, director and writer, *Cheney’s Law* (Frontline, 2007), DVD.


BIBLIOGRAPHY ENTRY


PODCAST (CMOS 14.267)

FOOTNOTE TEMPLATE

1. Podcast host and guest, “Title of podcast,” date, in *Title of Podcast Series*, produced by organization, podcast, MP3 audio, time length, accessed date, URL.

FOOTNOTE ENTRY


BIBLIOGRAPHY TEMPLATE

Podcast host and guest. “Title of episode.” Produced by organization. *Podcast Series Title*. Date aired. Podcast, MP3 audio, time length. Accessed date. URL.

BIBLIOGRAPHY ENTRY

WEBSITES

FORMATTING NOTES:

- If no publication date is available, include the month, day and year that you retrieved the document.
- Some webpages state when a page was last modified or updated. Include this wording with the date before the URL.
- Titles of websites are generally not italicized in Chicago style (CMOS 14.206). Not all websites have titles but rather an entity responsible for the site. Titles of blogs can be italicized. Titles of online newspapers or magazines are italicized.
- Titles of the webpage or article are set in quotation marks.

WEBPAGE WITH AN AUTHOR

FOOTNOTE TEMPLATE

1. Firstname Lastname, “Webpage Title,” Website Title, last modified/updated/accessed Month Day, Year, URL.

FOOTNOTE ENTRY


BIBLIOGRAPHY TEMPLATE

Lastname, Firstname. “Webpage Title.” Website title. Last modified/Accessed/Updated date. URL.

BIBLIOGRAPHY ENTRY


WEBPAGE – ORGANIZATION AS AUTHOR OR NO AUTHOR

Formatting notes:

- Often webpages that appear to have no author are authored by corporate entity or organization. List the organization or entity in place of the author. If the organization is also the name of the website, do not repeat that information.
- If there is no author, no organization and no website owner listed, start the entry with the title of the webpage.
- If no publication date is given, include the date the material was accessed. Accessed dates are not necessary if a publication date is given.
FOOTNOTE TEMPLATE

1. Organization or owner of the ENTIRE website, “Webpage title,” Title of Website or publisher of the ENTIRE website (if different than organization), last modified/accessed/updated date, URL.

FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY


BLOG POST (CMOS 14.208)

FOOTNOTE TEMPLATE

1. Firstname Lastname, “Title of Post,” Title of Blog (blog), Name of Larger Publication if applicable, Month Day, Year of post, URL.

FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY


LIBRARY OF CONGRESS DIGITAL COLLECTION (CMOS 14.229)

Note: The Library of Congress has a diverse digital collection of manuscripts and photographs available online (https://www.loc.gov/collections/). It’s a great place to find primary source material.

FOOTNOTE ENTRY


BIBLIOGRAPHY ENTRY

SOURCE NOTES:

This guide is based on the 17th edition of Chicago Manual of Style (2017). It also makes use of materials accessed through MVCC library’s database subscriptions, the Purdue Online Writing Lab (owl.purdue.edu), and the APA reference guide created by Danielle Del Giudice.

Please report suggestions and corrections to Danielle Del Giudice at ddel-giudice.mvcc.edu or Jocelyn Ireland at jireland@mvcc.edu.